
       GOSTEAM Hands-on Activity Template (Inquiry-based) 

 

Title: 

Optimal route finding and Least Cost Path concepts  

Short Description (Max 500 words): 

 Route finding is one of the most common problems in spatial modelling and geosciences 

overall. Optimal route planning, distribution networks and navigation are some aspects that 

are covered in our daily life based on optimal pathfinding algorithms. In this scenario, students 

will explore how some common spatial routines work, in terms of the multi-objectivity and 

different distance metrics (Euclidean and 3D distance), some important spatial attributes (i.e., 

neighborhood, adjacency), as also, some simple spatial modelling schemes to delineate optimal 

paths. Consequently, this scenario will enforce our knowledge to identify whether our GPS is 

lying or not (?). 

Keywords (Up to 5):  

Least Cost Paths (LCP), Network, Spatial Data, Optimization 

Information about the Implementation 

Age and language of the students:             9-12           12-15          15-18           18+ 

Language:  Greek   Age: 

Number of Lessons – Duration (per lesson):  

Number of Lessons:              3   Duration per Lesson:             45’ 

Subjects: 

For which subject(s) the activity is usable, is it an interdisciplinary activity?  

Science 

 Physics         Chemistry         Biology         Geosciences         Environmental         Other 

Technology 

Engineering 

Arts 

Mathematics 
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Information about the Scenario 

Curriculum and country: 

Link of the current activity to the curriculum: 

Country:   Greece   Class:  Upper Secondary Grade:  9 - 12  

    

Topic:   Mathematics, Applied Geometry,  
  Routeing problems 

 

Objectives (Max 100 words): 

Description of the learning objectives 

• Students will learn how the GPS navigation system works and overall, how pathfinding and 

routing problems are solved based on network (graph) structures. 

• Students will be able to discuss, compare, and negotiate methods used, results obtained, 

and explanations among groups conducting the same investigation. 

• The student will represent their ideas and solutions within text in the form of a report by 

incorporating graphs and maps. 

• Utilize tools geographers use to study the world for solving complex engineering and 

geometry-based problems. 

Materials (Max 100 words): 

Which resources and materials (software, hardware) are needed?  

  Material: Search Engines, Spatial Data, Printed maps and Online Support Material 

  Software: QGIS platform 

 

Spatial concepts, skills, and abilities: 

Which spatial concepts and skills are covered by the activity? 

Spatial concepts:  

Primitives: Identity/Name                Location       Space/Time 

Simple:     Distance Direction              Connectivity            Movement 

 Boundary         Shape/Area                  Adjacency 

Difficult:   Overlay  Buffer             Topology               Coordinate   

Map           Scale       Shortest Path Navigation 

Surface               Slope/Gradient            Aspect             Contour  

Complex: Interpolation     Map Projection                   Spatial Dependency   

Other: 
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Spatial skills: 

Map literacy 

Navigation/orientation 

Estimating distances and directions 

Recognizing and understanding patterns/Understand and identify models of 

spatial organization 

Select an ideal location based on the given spatial features 

Visualization 

Understand and identify spatial correlations/ dependencies 

Categorize spatial entities/ geographic features and identify hierarchies 

Compare spatial entities and draw analogies among them 

Identify/determine connections/relations 

Understanding scale in space and time 

Delineation of spatial regions/ zones based on given features/ properties 

Short Description 

Navigation/orientation: Finding one’s way in unfamiliar environments, interpreting and 
giving walking and driving directions.  
Estimating distances and directions: Measure paths, weighted distances, angles. 
Map literacy: Using, interpreting/understanding, learning from, and communicating 
acquired spatial knowledge from maps, comprehension of geographic features 
represented as points, lines, or polygons. 
Recognizing and understanding patterns/Understand and identify models of spatial 
organization. Delineation of spatial regions/zones based on given features/properties: 
Regionalization processes, pattern recognition and clustering identification in the 2d 
and/or the 3d world. 
Select an ideal location based on the given spatial features: Single or multi-criteria siting 
and optimal areas identification. 
Visualization: Visualizing spatial entities from written/oral verbal descriptions, from 
their 2d or graphical representations or through mental transformations; such as axis 
rotation or perspective taking. 
Understand and identify spatial correlations/ dependencies: The ability to realize, 
identify and explain patterns, clusters and relevant spatial dependencies. 
Categorize spatial entities/geographic features and identify hierarchies: Identify the 
hierarchical form of data and gradients between spatial entities. 
Compare spatial entities and draw analogies among them: Calculate and compare 
different geometric objects’ shapes, area and boundaries. 
Identify/determine connections/relations: The ability to identify links and common 
characteristics among spatial entities and between humans and spatial entities. 
Understanding scale in space and time: The understanding of changes/transitions 
through space and time for different spatio-temporal scales. 

 

Geospatial concepts and spatial abilities documentation (see Section 3.2): 

http://www.gosteam.eu/wp-content/uploads/2021/05/GOSTEAM_IO1_A1_final.pdf 

http://www.gosteam.eu/wp-content/uploads/2021/05/GOSTEAM_IO1_A1_final.pdf
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Description of the activity in detail 

Question Eliciting Activities 

Provoke curiosity 

Describe ways and materials that teachers will present to their students to attract their 

attention to the topic investigated.  

 Usually, the most effective way to provoke students’ curiosity is by presenting an exciting 

video or a series of photos or even using some interesting games or hands-on activities! 

 

 

 

 

 

 

 

 

 

 

 

Propose preliminary explanations or hypotheses 

Formulate the scientifically oriented questions that teachers will present to the students to 

trigger their engagement in thinking about the topic investigated based on their existing 

knowledge. Make these questions digitally available and easily usable, e.g., by integrating them 

in the materials described in the previous step. 

 It is best to ask these questions in the context of a relative discussion.  

To answer to the above-mentioned questions, we have to consider what type of 

problems the GPS solves? What do we want from our GPS? 

To delineate the shortest path! Or maybe better, the fastest path! 

Therefore, what is the fastest path to go to the school canteen? 

Or maybe the shortest? (in terms of the distance covered) Or the safest? 

START 

END 
Before the activity begins you can print 
the map on the right for each student 
and ask from them to delineate an 
optimal path from the starting to the 
ending point. 

They can move through each cell from 
each cell’s center to another from and 
to all directions! 

When the students finish their 
drawings and write their answers on 
the backside of the map ask them: 

 

Which criteria you used to select your 
path? 

Or why you selected this specific path? 
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In our daily activities when do we use or find pathfinding problems? 

Active Investigation 

Plan and conduct simple investigation 

Offer instructions about the activities the students will need to perform and what kind of 

materials they may need. Describe ways in order to facilitate the students to focus on evidence.  

This is the phase in which students are being prepared for the subsequent phase of 

evidence gathering during observation. 

First of all, students have to realize the actual scientific problem and topic, hence, 

what a Least Cost Path (LCP) algorithm is! 

Useful resources on the topic: 

https://gisgeography.com/least-cost-path-analysis/ (Examples of LCP) 

Route planning, pipelines and cables delineation, engineering applications, robotics, 

archaeology, animals’ corridors, hiking trail planning and many more! 

http://www.geography.hunter.cuny.edu/~jochen/gtech361/lectures/lecture11/con

cepts/Least-cost%20path%20analysis.htm (Least Cost Path concept explanation) 

https://blog.routific.com/route-optimization-google-maps-313a45e13d27 (Route 

optimization planning and GPS) 

 

In the following image you can see an indicative example of LCP implementation: 

 

0 1 2 3 4 5 6 7 8

0
50 50 50 40 40 40 30 30 30

1
50 50 50 30 30 10 10 10 10

2
50 50 40 20 20 10 20 20 30

3
50 40 20 40 30 30 10 40 40

4
50 40 20 50 50 20 30 30 40

5
50 40 30 50 30 40 40 40 50

6
50 30 30 20 50 40 40 30 40

7
50 50 50 40 40 50 50 50 30

8
50 50 50 50 40 50 50 40 50

B

A

Path x y z ED DH RD
A 7 1 10

6 1 10 1 0 1

5 2 10 1,414 0 1,414

4 2 20 1 10 10,05

3 2 20 1 0 1

2 3 20 1,414 0 1,414

2 4 20 1 0 1

2 5 30 1 10 10,05

B 1 6 30 1,414 0 1,414

9,243 27,34

Path x y z ED DH RD
A 7 1 10

6 1 10 1 0 1

5 1 10 1 0 1

4 2 20 1,414 10 10,1

3 2 20 1 0 1

2 3 20 1,414 0 1,414

2 4 20 1 0 1

2 5 30 1 10 10,05

B 1 6 30 1,414 0 1,414

9,243 26,98

Path x y z ED DH RD
A 7 1 10

7 2 20 1 10 10,05

6 3 10 1,414 -10 10,1

5 4 20 1,414 10 10,1

4 5 30 1,414 10 10,1

3 6 20 1,414 -10 10,1

2 6 30 1 10 10,05

1 6 30 1 0 1

B 8,657 61,5

↓

↓

↓

Figure 1: LCP considering 3D distance and slopes  

 

https://gisgeography.com/least-cost-path-analysis/
http://www.geography.hunter.cuny.edu/~jochen/gtech361/lectures/lecture11/concepts/Least-cost%20path%20analysis.htm
http://www.geography.hunter.cuny.edu/~jochen/gtech361/lectures/lecture11/concepts/Least-cost%20path%20analysis.htm
https://blog.routific.com/route-optimization-google-maps-313a45e13d27
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Using this specific example and considering that the moving distance from one cell to 

another in the cross directions (up, down, left, right) is 1, estimate the diagonal distance 

along with the 3D distances from A to B (black, green and red paths). 

ED: Euclidean distance, DH: Height difference, RD: Real distance on the ground 

Which is the shortest distance considering only the 2-dimensional space (from one cell 
to another)? 

To the contrary, if we also consider slopes (3-dimensional space), which is the shortest 
path and why? 

Compare the results! 

 

Creation 

Gather evidence from observation 

The selected resource (e.g., a simulation, an experiment, an animation, a graph, or other exhibit 

of similar nature) must provide students with an opportunity to collect evidence addressing the 

scientific questions presented in previous stages through direct or indirect observation.  

It is recommended to introduce group work at this stage. Teachers can divide students in 

groups, each of which will be facilitated by the teacher to formulate and to evaluate 

explanations to the scientific questions based on the collected evidence.  

Introduce all materials needed during the Activity along with short explanations: 

https://www.youtube.com/watch?v=8oEnJvLzDnQ (What is QGIS?) 

In order to better understand what type of data we will use and how we “translate” 

or model the Earth surface and processes, we have to discuss about spatial data 

structures (type of data and how spatial information is stored, data types etc.) 

https://www.youtube.com/watch?v=HwVFvHwuYJo (Vector and Raster data) 

QGIS Platform Download (version 3.14.0): 

https://qgis.org/downloads/ 

Download vectorized data for any place you want worldwide: 

https://extract.bbbike.org/ 

Before the beginning of the activity, students are separated to groups of 2. One of the group 

members is responsible for the tasks’ implementation, data acquisition and the appropriate 

steps to be followed during the activity. The second member is responsible for the results 

validation and communication, including the final report and the maps and results preparation 

and the results reporting. 

 

https://www.youtube.com/watch?v=8oEnJvLzDnQ
https://www.youtube.com/watch?v=HwVFvHwuYJo
https://qgis.org/downloads/
https://extract.bbbike.org/
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Step 1: Download spatial data in Shapefile format (vector data)  

 

 

 

Visit: 

https://extract.bbbike.org/ 

 

 

1. Navigate to the map by zooming in and out and dragging the map to the desire area 

you want to acquire data.  

2. Then select click here on the left of your screen to create the bounding box (See 

Figure 2).  

3. Draw a rectangle, fill your email address, and select Extract. The download link will 

be sent to your email account! 

 

Step 2: Download QGIS Interface (free online platform) 

Visit the following link and download QGIS 3.14 version depending on your operating 

system (OS). 

Figure 2: Bbike interface with the type of data an the area you want to search on the left and the 
global map on the right  

 

Figure 3: Drawing a rectangle to select your study area  

 

https://extract.bbbike.org/
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After installation finishes, from the Start menu on your desktop, navigate to the QGIS 

folder and open QGIS Desktop 3.14.0 with GRASS 7.8.3 and you will see the main 

window of QGIS platform as illustrated in Figure 4. 

In Figure 4 you can see some key functionalities and menus of the QGIS platform. The 

login of this activity is to load the vector data we have already downloaded on Step 1 

and process these data in order to extract some minimum cost paths, for example, from 

our home to school! 

To succeed that you have to: i) Load the data and ii) select the appropriate tools 

(algorithms) for delineating such paths upon different preferences. 

 

1. Navigate to your Downloads folder and “unzip” or “unrar” your compressed data. 

2. On QGIS use the Main toolbar (top of the screen) -> Layers -> Vector Layer -> 

Navigate to your folder and select roads.shp 

3. Change layout colors using Layer Properties (double-click on the .shp file you’ve 

loaded) -> Symbology -> Single line -> color. You can also change the line width or 

style (Stroke width) 

 

 Figure 4: QGIS interface and key functionalities 
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After you load your data and adjust you line colors (i.e to grey) you will see the results 

as illustrated in Figure 5. You can also zoom-in or zoom-out to your area.  

 

 

But what do we exactly see???? 

We see that the road network of the area we’ve selected consists of numerous 

lines/segments (roads) and nodes (junction points between roads).  

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5: Data visualization using QGIS (using grey color) 

1. Select roads layer 

2. Select Edit tool 

4. Double-click on 
one line segment 

5. The X signs 
are the roads’ 
nodes 

3. Press select 
attribute button 
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It is important that the crossing segments are split by nodes! WHY? In order to know: 

i) the turning points and ii) in order to be able to add different qualitative or 

quantitative information for each segment (i.e. max. speed, length, name etc.). 

Let’s visualize roads’ names on the map! But how the roads’ names are stored to this 

type of data? 

On the Attribute Table! See Figure 7. 

 

Right-click on the roads file and select “Open Attribute Table” 

You will see the Table on the right 

 

 

 

 

 

Now, we can visualize the roads’ names (See Figure 8) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Select 
Labels 3. Adjust size, font, background, or outer 

shading using Text and Bufer tabs 

4. Change labels color  

1. Double-click on 
roads.shp 

Figure 6: Roads’ network using lines and nodes 

Figure 7: Descriptive 
characteristics for 
each segment/line 

Figure 8: All appropriate steps you can follow in order to add labels on the map 
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Before we start analyzing paths, we must consider that we are using geospatial data, 

hence, all of these segments and nodes have a coordinate system!  

Which coordinate system? Double-click on the roads layer and select Source! 

 

 

 

 

 

 

 

 

 

 

Search for EPSG:4326 on Google and try to explain what it is? 

Read the first two results on Google. What units are used for the coordinates? How are 

the coordinates specified? Why is it called as a Geographic Coordinate System? 

Zoom-in for more 
detailed 

information! 

Figure 9: The results after adding the labels 

Figure 10: Coordinate System descriptive information 
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To change the coordinate system to a projected one, select on the main toolbar 

Vector > Data Management Tools > Reproject Layer and a new window opens (see 

Figure 11 on the right) 

 

 

 

 

 

 

 

 

On the new window (Reproject Layer) you select as input the roads file and as a target 

CRS (Coordinate Reference System) you can ask from student to select the projected 

coordinate system that is used in their country (e.g. for Greece is the Greek Grid, EPSG: 

2100). 

You save your file to your folder as roads_reprojected! 

Important note!!! Before you begin, go to the main toolbar and select Project > 
Properties > CRS > Search for the CRS you have already set in the previous Step and 
select it as your entire Project’s layers CRS! 
Why is that important? Because we want to estimate distances and times in meters 
and minutes, not in degrees! 

NOW WE ARE READY TO SEARCH FOR OPTIMAL PATHS!! 

To search for optimal paths we need specific algorithms. Here in QGIS to find these 

algorithms, we have to open the Processing Toolbox (see Figure 12, step 1) and go to 

Network analysis! 

Why will we use Network analysis (Figure 12, step 2)???? Because we have already 

downloaded a road network with line segments and nodes! 

 

Figure 11: Transform to a Projected Coordinate System  
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For extracting the shortest paths you must select the input vector layer (roads_repr), 
to set if you prefer the shortest or fastest path (here Shortest, see Figure 12, step 5) 
and most importantly to select a Starting and an Ending point (see step 5 in Figure 12).  

You can set the Start and End points by clicking the three dots on the right of the white 
box, and just hit a point on the map! 

Save you output file as Distance_path and you are done! DO NOT FORGET TO SAVE 
YOUR START AND END POINT ON A .TXT FILE!! 

The Shortest path result (red path) 

 

 

 

 

 

 

1. Open Processing Toolbox 

2. Go to 
Network 
Analysis 

3. Open Shortest 
Path  

(point to point) 

4. Input > roads_reproject 

5. Path type > Shortest 

5. Select Start and End Point on map. 

SOS: Save your points on a .txt file 

 

6. Save your file to the results folder as 
“Distance.shp”. 

Figure 12: Steps for identifying optimal shortest paths  
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But what if we want to compare the shortest path with the fastest? What information 
we must consider? The answer is….speed and as a result, time! 

How can we add this information? To the Attribute Table! This means that for each line 
segment (road) we must add the maximum speed limit!  

To succeed that, follow the Steps of Figure 13!!!! 

What do we want to do? To add a new field on the Attribute Table and set the maximum 
allowable speed per segment.  

Therefore, right-click on the roads_reproject layer > Open Attribute Table > Toggle 
editing in order to be able to add a new column to the roads_reproject layer (see Steps 
1-2, Figure 13). 

Click on Field Calculator (Step 3, Figure 13) > Select create new field and name it 
“speed_rand” (Step 4, Figure 13)! 

Why speed_rand? Because we are going to set a random speed for each segment rather 
than setting manually the appropriate speed for each segment. 

Finally, type “rand(20,60)” on the Expression box which means that for each segment, 
a random value between 20 and 60 km. will be added. 

rand(20,60) is a common programming expression. You can ask from students to search 
for similar random routines, for example, to select only floating random values at a 
specific range etc. 

 

START 

END 
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After creating and updating the maximum speed column, you can run once again the 

Shortest path algorithm! 

This time, you select as Path type > Fastest (Step 2, Figure 14) and the “speed field” of 
the Advanced Parameters (Step 4, Figure 14). 

Important note! Set the exact same Start and End points that you have already saved 
to the .txt file. 

Finally, save your layer as Time_A (Step 5, Figure 14)! 

Compare the results!!! (Figure 15) 

1. Right-click and open Attribute 
Table 

2. Toggle editing 3. Open field calculator 

4. Select Create new field 

Name: speed_rand 

Type: Whole number 

5. On the Expression 
box type: 

rand(20,60) 

Figure 13: Steps for adding the information needed for the speed limits  
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1. Input > Roads 

3. The same Start and End 
points from the .txt file 

2. Path type > Fastest 

4. Advanced parameters > 
Speed field > speed_rnd 

5. Save as > Time_A.shp 

Figure 14: Steps for identifying optimal fastest paths 

Figure 15: Comparison between the shortest and the fastest path 
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After comparing your results, you can test to update the speed limits of the 

“speed_rand” column! You can follow the steps of Figure 16 by Updating the values of 

an existing field on the Attribute Table! 

 

 

 

 

 

 

 

 

 

 

 

 

 

Shortest path 

Fastest path 

1. Select Update existing field 

2. Set field name > speed_rnd 

3. Update random 

speed values from 

10 to 80 using 

(rand(10,80) 

Run “Shortest Path” tool 

once again using the 

updated speed field! 

4. Save as > Time_B.shp 

Figure 16: Steps for updating the information needed for the speed limits  

Figure 17: Comparison between the shortest and the fastest paths 
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By right-clicking on the resulted layers “Distance”, “Time_A” and “Time_B” you can 

open their Attribute Table and identify the distance covered (in meters) or the time 

spent (hours). 

Advanced experimentation 

As an advanced scenario of the Shortest path approach you can select to remove (clip) 

segments and nodes from your network! In real life, this can be linked to potential road 

network maintenance, traffic etc. 

To succeed that, see Figure 17 and how you can select specific line segment using Select 
Features tool. After selecting the features you want to remove (yellow color in Figure 
17) you right-click on the roads_reproject layer > Export and follow the instructions of 
Figure 17! 

1. Click on Select Features by 

2. Select an area (left-click) 

3. Right-click on roads_reproject > Open Attribute 
Table and select Invert Selection! 

4. After that, right-click on roads_reproject and select 
Export 

5. Select folder and save as 
“roads_cut” 

6. SOS select save only 
selected features!!! 

PRESS OK 

Figure 18: Select and cut features from the network 
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By following the procedure of Figure 18 you will see your results (and the clipped 

area) as illustrated in Figure 19! 

Repeat the same procedure to estimate the Shortest and/or the Fastest paths! 

Compare the results and the increase of the total distance covered or the time spent 

to drive from the Start- to the End- point! 

 

 

 

 

 

 

 

 

 

 

 

 

 

Discussion 

Explanation based on evidence 

Guide the teachers to encourage their students to provide correct explanations for the topic(s) 

investigated.  

Describe ways and they can use to this end and give them directions how to discover them. 

You can ask from students if they can imagine the functions that are used in order 

to solve such a problem? 

You can think of the examples we used in Figure 1! 

Also, an analytical explanation is described here: 

https://learningactors.com/minimum-cost-path-analysis-python/ 

CLIPPED AREA 

Figure 19: Final roads network after clipping a specific area (top left) and the 

resulted shortest path after running the Shortest path algorithm once again 

https://learningactors.com/minimum-cost-path-analysis-python/
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Can they realize now the options that are provided to a user on the GPS???? 

For instance, why on the GPS we can select to drive using highways or excluding tolls and 

why the arrival time changes. 

 

Consider other explanations 

Facilitate the student groups to evaluate their own explanations in the light of 

alternative explanations, particularly those reflecting scientific understanding. 

Illustrate examples they can use and give them instructions how to locate them.  

Which other criteria you think that might be used in Least Cost Path problems? For 

example, on the Google Maps navigation tool? 

See the following video about the traffic monitoring: 

https://www.priteshpawar.com/how-google-maps-works/technology-

explained/priteshpawar/ 

What if we have to estimate the Maximum path or the Longest? (Advanced) 

Just simply return the positive distances (i.e. weights) to negative right? Well, it is 

not that simple! See some examples: 

https://stackoverflow.com/questions/23256534/maximum-profit-using-dijkstra-

algorithm 

https://en.wikipedia.org/wiki/Cycle_(graph_theory) 

https://en.wikipedia.org/wiki/Directed_acyclic_graph 

 

Reflection 

Communicate explanation 

Facilitate each student group to reflect on the previous experiences and to produce a report 

with its findings, presenting and justifying the proposed explanations to the other groups and 

the teacher. 

Provide content which the teacher can use to help the students to get familiarized and to 

become efficient in scientific writing. 

https://www.priteshpawar.com/how-google-maps-works/technology-explained/priteshpawar/
https://www.priteshpawar.com/how-google-maps-works/technology-explained/priteshpawar/
https://stackoverflow.com/questions/23256534/maximum-profit-using-dijkstra-algorithm
https://stackoverflow.com/questions/23256534/maximum-profit-using-dijkstra-algorithm
https://en.wikipedia.org/wiki/Cycle_(graph_theory)
https://en.wikipedia.org/wiki/Directed_acyclic_graph
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Ask from students to write a short report by incorporating the scope of this Activity 

(which is the objective?), the data and the tools they used, what methodology 

(algorithms) and to present their results in the form of maps (images) by reporting 

the Minimum distances and the total time needed. 

They can also report all potential adjustments they made (clipping areas, speed 

estimation using random values) or any future research they want to consider (add 

some criteria or a simplified version of a Monte Carlo simulation considering the 

Fastest paths and the random speeds). 

The report outline could be in the form of:  
 

i) Introduction,  

ii) Relevant information about Least Cost Path algorithms and the GPS,  

iii) Study area and Data used,  

iv) Methodology,  

v) Results and Discussion and finally,  

vi) Conclusions and Future work 

 

Follow-up activities and materials 

Describe and direct the user to any follow-up activities or materials that can be used to wrap-

up the hands-on activity.  

These could include appropriate learning assessment and/or reminder materials (e.g.,  

quizzes, games, other user-friendly tests), hints for further activities etc. 
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Return on the initial “Questions eliciting 

activities map” and ask from students to 

delineate again the shortest path from 

the START to the END point! 

 

 

 

 

 

Tell them that they have to consider the 

criteria of the distance and the terrain 

slopes! 

 

 

Sustainable contact 

Name & email: Loukas Katikas (lkatikas@ea.gr) & 

Name & email: Eleftheria Tsourlidaki (eleftheria@ea.gr) 

 

References (if any): 

Examples of LCP:  https://gisgeography.com/least-cost-path-analysis/  

Least Cost Path concept explanation: 

http://www.geography.hunter.cuny.edu/~jochen/gtech361/lectures/lecture11/conce

pts/Least-cost%20path%20analysis.htm  

Route optimization planning and GPS:  https://blog.routific.com/route-optimization-

google-maps-313a45e13d27 

Minimum Cost Path Analysis using Python: https://learningactors.com/minimum-cost-

path-analysis-python/ 

Cycles and Graph theory: https://en.wikipedia.org/wiki/Cycle_(graph_theory) 

Directed acyclic graph explanation: 
https://en.wikipedia.org/wiki/Directed_acyclic_graph 

START 

END 

mailto:lkatikas@ea.gr
https://gisgeography.com/least-cost-path-analysis/
http://www.geography.hunter.cuny.edu/~jochen/gtech361/lectures/lecture11/concepts/Least-cost%20path%20analysis.htm
http://www.geography.hunter.cuny.edu/~jochen/gtech361/lectures/lecture11/concepts/Least-cost%20path%20analysis.htm
https://blog.routific.com/route-optimization-google-maps-313a45e13d27
https://blog.routific.com/route-optimization-google-maps-313a45e13d27
https://learningactors.com/minimum-cost-path-analysis-python/
https://learningactors.com/minimum-cost-path-analysis-python/
https://en.wikipedia.org/wiki/Cycle_(graph_theory)
https://en.wikipedia.org/wiki/Directed_acyclic_graph
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Assessment (if any): 

 


